
 Check! 97 GradeBook    Help Index
How To ...

<<add your application-specific "how to" topics here>>

Commands
File menu
Edit menu
Insert menu
View menu
Window menu
Help menu



File menu commands

The File menu offers the following commands:

New Gradebook Wizard Creates a new gradebook .
Open Opens an existing gradebook .
Close Closes an opened gradebook .
Save Saves an opened gradebook    using the same file 

name.
Save As Saves an opened gradebook    to a specified file name.
Print Prints a gradebook .
Print Setup Selects a printer and printer connection.
Send Student Network... Sends the active gradebook    through electronic mail.
Exit Exits Check! 97 GradeBook .



Edit menu commands

The Edit menu offers the following commands:

Student entry edit/delete Edit a student that already entered in a gradebook.
Student score Edit a student’s score that is already entered in the gradebook
Student attendance edit Edit a student’s attendance record entry already in the 

gradebook.
Grade entry edit/delete Edit a grade entry already entered in a gradebook
Attendance entry delete Delete an Attendance entry already entered into the gradebook
Class information and grading 
schema

Edit the Class information and the way the current gradebook 
calculates the students’ grades

Change score for every student Cycle through all of the students entered into the gradebook, 
and updating each student score for a selected grade. 

Curve Wizard Invokes the Curve Wizard.
Syllabus Wizard Invokes the Syllabus Wizard



Insert menu commands

The Insert menu offers the following commands:

Student entry add Inserts a student into the 
gradebook.

Grade entry add Inserts a grade into the 
gradebook

Attendance entry add Inserts an attendance entry 
into the gradebook.

Roster Import Uses a text file to import all 
students into the gradebook.

View menu commands

The View menu offers the following commands:

Scores Histogram Toggles the histogram displays 
as 3D graph to Bar graph

Toolbar Shows or hides the toolbar.
Status Bar Shows or hides the status bar.

Window menu commands

The Window menu offers the following commands, which enable you to arrange multiple 
views of multiple gradebook s in the application window:

New Window Creates a new window that views the same gradebook .
Cascade Arranges windows in an overlapped fashion.
Tile Arranges windows in non-overlapped tiles.
Arrange Icons Arranges icons of closed windows.
Split Split the active window into panes.
Window 1, 
2, ...

Goes to specified window.



Help menu commands

The Help menu offers the following commands, which provide you assistance with this 
application: 

Help Topics Offers you an index to topics on which you can get 
help.

About Displays the version number of this application.



New command (File menu)

Use this command to create a new gradebook in Check! 97 GradeBook .    Check! Gradebook 
will start the Gradebook Wizard which is a step by step series of questions to help you with 
your gradebook.

You can open an existing gradebook    with the Open command.

Shortcuts

Toolbar:
Keys: CTRL+N



Open command (File menu)

Use this command to open an existing gradebook in a new window.    You can open multiple 
gradebook s at once.    Use the Window menu to switch among the multiple open 
gradebooks.    See Window 1, 2, ... command.

You can create new gradebooks with the New Gradebook Wizard.

Shortcuts

Toolbar:
Keys: CTRL+O



File Open dialog box

The following options allow you to specify which file to open:
File Name

Type or select the filename you want to open.    This box lists files with the extension you 
select in the List Files of Type box. 

List Files of Type
Select the type of file you want to open:
*.gb are the gradebook files.
*,gb.BACKUP are the corresponding backup files for gradebooks.

Drives
Select the drive in which Check! 97 GradeBook    stores the file that you want to open. 

Directories
Select the directory in which Check! 97 GradeBook    stores the file that you want to 
open.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Close command (File menu)

Use this command to close all windows containing the active gradebook.    Check! 97 
GradeBook suggests that you save changes to your gradebook before you close it.    If you 
close a gradebook without saving, you lose all changes made since the last time you saved 
it.    Before closing an untitled gradebook, Check! 97 GradeBook displays the Save As dialog 
box and suggests that you name and save the gradebook .

You can also close a gradebook by using the Close icon on the gradebook’s window, as 
shown below:



Save command (File menu)

Use this command to save the active gradebook to its current name and directory.    When 
you save a gradebook for the first time, Check! 97 GradeBook displays the Save As dialog 
box so you can name your gradebook.    If you want to change the name and directory of an 
existing gradebook before you save it, choose the Save As command.

Shortcuts

Toolbar:
Keys: CTRL+S



Save As command (File menu)

Use this command to save and name the active gradebook .    Check! 97 GradeBook displays
the Save As dialog box so you can name your gradebook.    

To save a gradebook with its existing name and directory, use the Save command.



Send Student Network command (File menu)

Use this command to send the active gradebook through electronic mail.    This command 
presents a mail window with the active gradebook attached to it.    Before opening the mail 
window Check! gradebook will ask if you would like to place onto the clipboard a list of all 
the email addresses that are currently entered into the gradebook under the student’s 
record.    Click yes to paste this list onto the clipboard.    You may then fill out the To: field, 
Subject: field, etc., and add text to the body of the message if you wish.    If you chose the 
option to paste to the clipboard the list of email addresses,    place the cursor in the To: field 
and then press the paste button on the toolbar or press on the keyboard SHIFT-INSERT to 
supply the list from the clipboard to the mail window.    When you are finished you may click 
the "Send" button to send the gradebook to the email addresses      This command is only 
available if you have a mail client installed on your machine.

Shortcuts

Toolbar:



File Save As dialog box

The following options allow you to specify the name and location of the file you're about to 
save:
File Name

Type a new filename to save a gradebook with a different name.    A filename can contain
up to eight characters and an extension of up to three characters.    If you are working in 
windows 95 you may include a long filename as well.    Check! 97 GradeBook adds the 
extension you specify in the Save File As Type box.

Drives
Select the drive in which you want to store the gradebook .

Directories
Select the directory in which you want to store the gradebook .

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four 
gradebooks you closed.    Choose the number that corresponds with the gradebook you want 
to open.



Exit command (File menu)

Use this command to end your Check! 97 GradeBook    session.    You can also use the Close 
command on the application Control menu.    Check! 97 GradeBook prompts you to save 
gradebooks with unsaved changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Student entry edit/delete command (Edit menu)
Use this command to edit or delete a student from the gradebook.    When this command is 
selected, a dialog box with a list of all students entered into the gradebook appears.

Select a student from the list and then choose the “Edit” or “Delete” buttons.    A shortcut to 
this operation is to DOUBLE-CLICK the student’s name in the tree view from the main 
window display.

Shortcuts
Mouse DOUBLE-CLICK on the students name in the tree view.



Student score command (Edit menu)

Use this command to change a student’s score for a particular grade.    When this command 
is selected a window with two lists appears.

Select a student from the list on the left and then select a grade from the list on the    right.
Press the “Update Score” button and a window will prompt you for the new score.    A short 
cut to this is to    DOUBLE CLICK the grade name underneath the student name in the tree 
view from the main window display

Shortcuts

Toolbar:
Mouse:DOUBLE-CLICK the grade name below a student in the tree view.



Grade entry edit/delete command (Edit menu)

Use this command to edit or delete a grade from the gradebook.    When this command is 
selected, a dialog box with a list of all grades entered into the gradebook appears.

Select a grade from the list and then choose the “Edit” or “Delete” buttons.



Class information and grading schema command (Edit menu)

Use this command to edit and update the class information and grading information that you
provided in the New Gradebook Wizard.    The class information contains topic information 
about the class which the gradebook is for.    This includes the grade breaks, and group 
percentages.

Shortcuts
Mouse: DOUBLE-CLICK the Root name (File name) in the tree view.



Change score for every student command (Edit menu)

Use this command to change the score for every student for a selected grade.    This 
command is identical to Student score except that Check! cycles through all the students
prompting for a score change for that selected grade.



Curve Wizard command (Edit menu)

Use this command to invoke the Curve Wizard.    The Curve wizard is a utility that shifts the 
bell curve for a particular grade.    The Curve Wizard does this by finding the highest score in 
the group of scores.    The Curve Wizard then uses the difference of the highest grade and 
the MAX Points for that grade as a suggested number of points to adjust each students score
by. 

Shortcuts

Toolbar:



Syllabus Wizard command (Edit menu)

Use this command to invoke the Syllabus Wizard.    The Syllabus wizard is a utility that allows
you to produce a “contract” of how the course is to be taught between you and your 
students.    Check! uses the class information that you provide to produce a “template” 
document that is then sent to Wordpad for you to complete.    If you do not have Wordpad, 
then you may open this .slb file with the editor of your choice.



Student entry command (Insert menu)

Use this command to add a student into the current gradebook.    By invoking this command 
a window will appear prompting you for information on a student.

All fields a self explanatory and necessary except for the student Id Number.    This Id 
number is used by Check! and by Grade! for identification purposes.    After you have 
entered in the necessary fields press the OK button to save the student in the gradebook.    If
you are inputting more than one student into the gradebook then you may press the “Add 
Another” button.    To edit or delete a student see Student entry edit/delete 



Grade entry command (Insert menu)

Use this command to add a grade into the gradebook.    After you input a grade into the 
gradebook Check! will cycle through all of the students, prompting for a score. To edit or 
delete a grade entry see Grade entry edit/delete 

Shortcuts

Toolbar:



Roster Import command (Insert menu)

Use this command to import from a text file your roster into the gradebook, saving you time 
by not having you individually input each student.    This file can usually be obtained by your 
school’s system administrator.    After you have obtained this file use an editor    like Notepad 
or Wordpad to examine the contents of this file, noting the format.    Note that the Id Number
and the email address will not be assigned if it is lacking in your roster file.    Once there are 
students and/or grades entered into the gradebook Check! will not allow this command to 
perform.



Scores command (View menu)

Use this command to toggle the display of the histogram charts from a 3D histogram to a 
simple bar graph.



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the 
most common commands in Check! 97 GradeBook , such as File Open.    A check mark 
appears next to the menu item when the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The 
toolbar provides quick mouse access to many tools used in Check! 97 GradeBook ,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click To

Open a new gradebook .

Open an existing gradebook .    Check! 97 GradeBook    displays the Open dialog box, 
in which you can locate and open the desired file.

Save the active gradebook    or template with its current name.    If you have not 
named the gradebook , Check! 97 GradeBook    displays the Save As dialog box.

Print the active gradebook .

Inserts a new grade into the gradebook.

Open a new gradebook .

Invokes the Curve Wizard.

Sends the Student Network via email.



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be 
executed by the selected menu item or depressed toolbar button, and keyboard latch state. 
A check mark appears next to the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the Check! 97 GradeBook    window.    To display 
or hide the status bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to 
navigate through menus.    This area similarly shows messages that describe the actions of 
toolbar buttons as you depress them, before releasing them.    If after viewing the description
of the toolbar button command you wish not to execute the command, then release the 
mouse button while the pointer is off the toolbar button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.
NUM The Num Lock key is latched down.
SCRL The Scroll Lock key is latched down.



New command (Window menu)

Use this command to open a new window with the same contents as the active window.    You
can open multiple gradebook    windows to display different parts or views of a gradebook    
at the same time.    If you change the contents in one window, all other windows containing 
the same gradebook    reflect those changes.    When you open a new window, it becomes the
active window and is displayed on top of all other open windows.



Cascade command (Window menu)

Use this command to arrange multiple opened windows in an overlapped fashion. 



Tile command (Window menu)

Use this command to arrange multiple opened windows in a non-overlapped fashion.



Tile Horizontal command (Window menu)

Use this command to vertically arrange multiple opened windows in a non-overlapped 
fashion.



Tile Vertical command (Window menu)

Use this command to arrange multiple opened windows side by side.



Window Arrange Icons Command

Use this command to arrange the icons for minimized windows at the bottom of the main 
window.    If there is an open gradebook    window at the bottom of the main window, then 
some or all of the icons may not be visible because they will be underneath this gradebook    
window.



Split Command (Window menu)

Use this command to split the active window into panes.    You may then use the mouse or 
the keyboard arrows to move the splitter bars.    When you are finished, press the mouse 
button or enter to leave the splitter bars in their new location.    Pressing escape keeps the 
splitter bars in their original location.    << In a single gradebook    interface application, this 
command will appear on the View menu. >>



1, 2, ... command (Window menu)

Check! 97 GradeBook    displays a list of currently open gradebook windows at the bottom of 
the Window menu.    A check mark appears in front of the gradebook name of the active 
window.    Choose a gradebook from this list to make its window active.    



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can
jump to step-by-step instructions for using Check! 97 GradeBook and various types of 
reference information.    

Once you open Help, you can click the Contents button whenever you want to return to the 
opening screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of 
Check! 97 GradeBook.



Context Help command 

Use the Context Help command to obtain help on some portion of Check! 97 GradeBook .    
When you choose the Toolbar's Context Help button, the mouse pointer will change to an 
arrow and question mark.    Then click somewhere in the Check! 97 GradeBook    window, 
such as another Toolbar button.    The Help topic will be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

The title bar is located along the top of a window.    It contains the name of the application 
and gradebook .

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging 
their title bars.

A title bar may contain the following elements:
Application Control-menu button
Gradebook    Control-menu button
Maximize button
Minimize button
Name of the application
Name of the gradebook 
Restore button



Scroll bars

Displayed at the right and bottom edges of the gradebook    window.    The scroll boxes inside
the scroll bars indicate your vertical and horizontal location in the gradebook .    You can use 
the mouse to scroll to other parts of the gradebook .

<< Describe the actions of the various parts of the scrollbar, according to how they behave 
in your application. >>



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the
arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer 

to the border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or 
dialog box with the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the Check! 97 GradeBook    window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a gradebook    window.



Next Window command (gradebook    Control menu)

Use this command to switch to the next open gradebook    window.    Check! 97 GradeBook    
determines which window is next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window command (gradebook    Control menu)

Use this command to switch to the previous open gradebook    window.    Check! 97 
GradeBook    determines which window is previous according to the order in which you 
opened the windows.

Shortcut
Keys: SHIFT+CTRL+F6



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single gradebook , the Close command on 
the gradebook    Control menu closes only one window at a time.    You can close all windows 
at once with the Close command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a gradebook    window

ALT+F4 closes the gradebook window or dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the 
Maximize or Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to 
or close an application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the 
following options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option 
does not affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not 
affect applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



Ruler command (View menu)

<< Write application-specific help here. >>



Choose Font dialog box

<< Write application-specific help here. >>



Choose Color dialog box

<< Write application-specific help here. >>



Find command (Edit menu)

<< Write application-specific help here. >>



Find dialog box

<< Write application-specific help here. >>



Replace command (Edit menu)

<< Write application-specific help here. >>



Replace dialog box

<< Write application-specific help here. >>



Repeat command (Edit menu)

Use this command to repeat the last editing command carried out.    The Repeat menu item 
changes to Can't Repeat if you cannot repeat your last action.

Shortcut
Key: F4



Clear command (Edit menu)

<< Write application-specific help here. >>



Clear All command (Edit menu)

<< Write application-specific help here. >>



Next Pane

<< Write application-specific help here. >>



Prev Pane

<< Write application-specific help here. >>



Modifying the Gradebook 

<< Write application-specific help here that provides an overview of how the user should 
modify a gradebook    using your application.    

If your application supports multiple gradebook    types and you want to have a distinct help 
topic for each, then use the help context i.d. generated by running the MAKEHELP.BAT file 
produced by AppWizard.    Alternatively, run MAKEHM as follows:

makehm IDR_HIDR_,0x2000 resource.h

If the IDR_ symbol for one of your gradebook    types is, for example, IDR_CHARTTYPE, then 
the help context i.d. generated by MAKEHM will be HIDR_CHARTTYPE.

Note, AppWizard defines the HIDR_DOC1TYPE help context i.d. used by this help topic for the
first gradebook    type supported by your application.    AppWizard produces an alias in 
the .HPJ file for your application, mapping HIDR_DOC1TYPE to the HIDR_ produced by 
MAKEHM for that gradebook    type. >>





No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.

<< If you wish to author help specific to each message box prompt, then remove the 
AFX_HIDP_xxx values from the [ALIAS] section of your .HPJ file, and author a topic for each 
AFX_HIDP_xxx value.    For example, AFX_HIDP_INVALID_FILENAME is the help topic for the 
Invalid Filename message box. >>



Add/Edit Student Window

Student’s Lastname:
In this field you need to supply the student’s lastname.      Required.
Student’s Firstname:
In this field you need to supply the student’s Firstname.      Required.
Students’s Id Number:
In this field you need to supply the student’s Id number.    Also you may use this field to 
supply a password.    This field is used by The accompanying Grade! program for students to 
look at their grades.
Student’s Email:
Use this field to supply the student’s email address.
Student’s Status:
Student’s ‘state’ can be one of three values.    By default the student is set to ‘Normal.’



Add/Edit Grade Window

Grade name:
In this field you need to supply the name of the grade.      Required.
Date:
In this field you need to supply the date.    This is a free format, i.e. you may provide a 
numeric date (03/05/97) or a combination date(Mar 03, 1997)
Max points:
In this field you need to supply the Maximum number of points a student can earn for this 
grade.
Weight:
Use this field to supply the Weight of a grade.    By default all grade weights are set (1).
Group:
Supply the group that this grade belongs to.    This categorizes this grade in a certain 
percentage group of the total grade.



Course info Window
The majority of these fields are used for printed reports and identification purposes though 
out the gradebook.    When filling out this window please try not to leave any field blank.
Course Number:
In this field supply the course number if applicable.
Course Name:
In this field supply the name of the class that this gradebook is for.
Section:
If this class has a section number supply it here.
Year:
The year that the class is being taught.
Instructor:
The greatest teacher of all time.
Term:
Which semester term this class is being taught.



Breaks Window
This windows is where you will define the grade breaks for this class gradebook.    By default 
the breaks are set to the 90,80,70,60 format but you may choose to edit them if you wish.



Group option Window
This windows is where you will define the a group option.    This option consists of three 
choices that a group can have.    By default this option is set to ‘Don’t drop any from group.’   
It also allows you to drop up to the lowest to scores from a defined group of grades.
For example, suppose you have a group of grades called ‘TESTS’ that are 60% of the total 
grade.    You may elect to drop the lowest score of each student in the group ‘TESTS’ by 
selecting the group option ‘Drop lowest score in group.’



Groups Window
This window collects the groups that you will define for your class.    There can be up to 
seven groups in your class.    The first column is the group name itself.    These can be made 
of any name you wish, for example ‘TESTS’,’ASSIGNMENTS’,’LABS’,or ‘FINAL.’    The second 
column is the percentage weight of the final grade that a group has.    For all groups that are 
being used, they must total 100.    See example below.

As you can see, all groups defined total 100.    If you do not want a group to be counted into 
the total grade then you can leave it to ‘undefined’ and set its percentage to 0.    The last 
column is a button to set the group option. These options allows even more flexibility with 
your grading for a specified group by allowing you to drop lowest scores , if you wish, from a 
group.



Edit Grade Window
This windows is where you select which grade you wish to change.    Select a grade from the 
list on the left and the press the ‘Edit Grade’ button or the ‘Delete Grade’ button depending 
on what task you wish to perform.    When you delete a grade, all student’s scores are erased
from their records and their Final grade is automatically updated.    If you choose to edit the 
grade Check! automatically updates all students grades to reflect the changes made.



Edit Student Window
This windows is where you select which student you wish to change.    Select a student from 
the list on the left and the press the ‘Edit Student’ button or the ‘Delete Student’ button 
depending on what task you wish to perform.



Roster Import Selection Window
This windows is where you select what format characteristics your roster files has.    If you 
are unsure of what the format is use an editor(such as wordpad) to open the roster file 
note the layout of the file.    If you don’t have a roster file then you can easily make one your 
self by creating a simple textfile by following any one of the formats listed by this window.    
This may ease in your inputting of students if your school does not provide a roster file to 
you.



Input score Window
This windows is where you assign a score for a student for the given listed grade.    Place the 
number of points that the student has earned in the edit field and press OK.



Change Score Window
This windows is where you select a student from the list from the left and then select a 
grade from the list on the right.    After you have selected from both list you may press the 
‘Update Score’ button and the Change socre window will appear.    A shortcut to updating a 
students score is to DOUBLE-CLICK the grade name under the desired student in the main 
window’s tree view.



Group Option Window
This windows is where you can select the option to drop up to the lowest 2 scores of a group.
For example if you have a Group called ‘Tests’, you may use this option to drop the lowest 
two scores by selecting ‘Drop lowest scores in group’ button.



Select Grade Window
This windows is where you select a grade from the list from the left.    After you have 
selected from the list you may press the OK button.



Print Dialog Window
This windows is where you select what kind of report you wish to print.
Roll Sheet:
This option produces a list of all the students that are entered into the gradebook
Full Report:
This option produces a full report of all students and their scores, and final grade earned to 
date.
Current Selected Tab:
This option prints the current selected tab in the main view window.    If the current tab 
selected is the ’Spreadsheet’ tab, then a full report is produced.



Wizard page
This page is part of the New Gradebook Wizard option. Please read the page for instructions.



Wizard page
This page is part of the New Gradebook Wizard option. Please read the page for instructions.



Wizard page
This page is part of the New Gradebook Wizard option. Please read the page for instructions.



Wizard page
This page is part of the New Gradebook Wizard option. Please read the page for instructions.



Roster Wizard page
Use this option to tell the New Gradebook Wizard that you have a roster file to    import.    
After the Wizard has run and you have selected this option, Check! gradebook will ask you 
the location of you roster file.



Wizard page
This page is part of the New Gradebook Wizard option. Please read the page for instructions.



GradeBook display
This is the main display of Check! Gradebook.    It is divided into two different areas. First, on 
the left, there is the tree view which lists all of the students and their scores for grades.    
Next, on the right, there is the tabbed displays.    The first tab is the spreadsheet which gives
a column listing of all the students and their scores for grades.    The next series of tabs are 
of histogram display so that you can graphically see how students are performing on grades.
There are various shortcuts in this view,    try Double-clicking on tree items to see what 
happens!
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Common Check! Vocabulary
GradeBook: This is where all of a class’s information is stored.    Check! is setup much like a 
word processor on a computer.    A word processor has documents that a user can open up to
edit, sometimes more than one at a time. Analogously Check! has gradebooks that are 
opened to edit, even several at a time!

Student: The main reason you started teaching in the first place.    All of the student records 
have four fields; Student’s Lastname, Student’s Firstname, Student’s Id Number, 
and Student status.

Grade:        The grade record is the definition of the assignment itself.    The Grade record sets 
the Grade Name, a date, The MAXimum number of Points for that grade, the Weight of 
the grade, if the grade is going to be Included in the Final Grade assigned to the student, 
and the Group that the grade is assigned to.

Score: This is the total points that a student achieves in a grade.

Group: Each Grade is assigned to a specified Group.    These groups could be Tests, 
Assignments, Final, Projects, Attendance, Labs, etc...    Every group has their own 
Percentage Weight.    That is, what percentage of the total grade is that specified group.    
The sum of these percentage weights must total 100.0.    Also, each group has their own 
Group options.    These options tell Check! whether or not to drop the lowest grade(s) or 
not.    Setting these options will be explained later in the manual

Grade Breaks: These are the percentages that are assigned that define in what grade 
bracket a student’s total grade falls in.

Course Info: Every class has a topic that it will cover.    This Course Name, Number, and 
Section  define the basic subject of the class.    Also the Year, Term, and Instructor are 
included in the course info.

Student Network: Check! has the ability to mail a copy of the grades to students.    These 
students who are in the class, can view their only their own grades so that they may see 
where their scores, final grade, and class standing is at, without having to make an 
appointment with the instructor.    This is viewing of the grades is done with the separate 
Grade! program that is supplied with Check!    Also since this is an email with an attachment,
a teacher can broadcast messages to the class, keeping students up to date with any class 
announcements.



How Check! calculates students grades
Check!, using the scores and grades supplied , calculates grades in the following manner:

First Check!” weights all    scores by multiplying each students score by its respected grade 
weight.

( Test1) 

( Test2)    

( Assignment1)    

 (Assignment2)    

(Final)

Second, all “weighted” scores, in a group, are added together.
Tests

      = .965
Assignments

Final

Third, all added scores are multiplied by the groups percentage
Tests (group percentage is 70%)
.965 * .70 = .6755

Assignments (group percentage is 10%)
.8 * .10 = .08

Final (group percentage is 20%)
.9    * .20 = .18

Last , groups are added together to produces the student’s final score

.6755 + .08 + .18 = .9355 = 93.55% “A”



Attendance entry add command
This command adds an attendance entry into the gradebook.    When selected, theis 
command cycles through all the students entered into the gradebook and asks for an 
attendance record.



Student attendance edit command
This command edits an attendance entry already entered into the gradebook.



Attendance entry delete command
This command deletes an attendance record already entered into the gradebook. 



Attendance add window
This window collects the attendance information for the current student listed int the 
window.    Select the appropriate button and then press the OK button.



Attendance entry change window
Select a student on the left then select and entry on the right to bring up the Attendance 
edit window to change a student’s attendance record.



Delete Attendance entry window
This Window allows you to delete an attendance record from the gradebook.    By selecting a 
record from the list on the left and then pressing the ‘Delete record’ button the record for 
each student will be deleted.



How to read the graphs in Check! Gradebook

Using the graph below the gathering of useful information about a particular grade and how 
the students performed can be utilized.    Above it is evident that close to 25% of the 
students had a score of 80% for this grade.    The standard deviation is another tool to 
measure how well the students understand the material    for that grade.    The smaller the 
standard deviation, the more tightly coupled the scores are to one another.    In 
mathematical terms, the standard deviation is the average distance of each score from the 
average score. 



Warranty Inforamation

30 Limited Warranty
Calico Educational Software warrants to the Purchaser that the software media will be free from defects in materials and workmanship and that 
the software will execute its programming instructions when properly installed.    Calico Educational Software does not warrant that the software 
will be uninterruptible or error free.

If Calico Educational Software receives notice of such defects during the warranty period, Calico Educational Software will, at its option, will 
replace such media.    To obtain such service, Purchaser must return the media with an authorization code that may be obtained by contacting 
Calico Educational Software.    Any claim to this warranty must include a dated proof of purchase or invoice.    If Calico is unable, within a 
reasonable time, to repair or replace any product then purchaser shall be entitled to a refund of the purchase price.

CALICO EDUCATIONAL SOFTWARE MAKES NO OTHER EXPRESS WARRANTY WHETHER WRITTEN OR ORAL.    ANY IMPLIED 
WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE IS LIMITED TO THE 30 DAY    WRITTEN 
WARRANTY. Some states or provinces do not allow limitation on how long an implied warranty lasts, so the above limitations or exclusions 
may not apply to you.    This warranty gives you specific legal rights any you may have other rights that may vary from state to state or province 
to province.

THE REMEDIES PRINTED ABOVE ARE PURCHASER’S SOLE AND EXCLUSIVE REMEDIES. IN NO EVENT SHALL CALICO 
EDUCATIONAL SOFTWARE BE LIABLE FOR ANY DIRECT, INDIRECT, SPECIAL OR CONSEQUENTIAL DAMAGES( INCLUDING 
LOST PROFITS) WHETHER BASED ON CONTRACT, TORT OR ANY OTHER LEGAL THEORY. Some states or provinces do not allow the
exclusion or limitation of incidental of consequential damages so the above limitations or exclusions may not apply to you.

Software Media License

· The purchaser may only install the gradebook program (Check!) on one computer.

· The purchaser may install the student network program (Grade!) on as many computers as the purchaser wishes as long as each 
installed student network program(Grade!) in used in conjunction with the legally purchase gradebook program(Check!)

· The accompanying written user’s guide may not be copied or duplicated in whole or in portion with out the written consent of Calico 
Educational Software.





Print command (File menu)

Use this command to print a document.      This command presents a Print dialog box, where 
you may specify the range of pages to be printed, the number of copies, the destination 
printer, and other printer setup options.

Shortcuts

Toolbar:
Keys: CTRL+P



Print dialog box

The following options allow you to specify how the document should be printed:
Printer

This is the active printer and printer connection.    Choose the Setup option to change the
printer and printer connection.

Setup
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Range
Specify the pages you want to print:
All Prints the entire document.
Selectio
n

Prints the currently selected text.

Pages Prints the range of pages you specify in the From and To boxes.
Copies

Specify the number of copies you want to print for the above page range.
Collate Copies

Prints copies in page number order, instead of separated multiple copies of each page.
Print Quality

Select the quality of the printing.    Generally, lower quality printing takes less time to 
produce.



Print Progress Dialog

The Printing dialog box is shown during the time that <<YourApp>> is sending output to the
printer.    The page number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Preview command (File menu)

Use this command to display the active document as it would appear when printed.    When 
you choose this command, the main window will be replaced with a print preview window in 
which one or two pages will be displayed in their printed format.    The print preview toolbar 
offers you options to view either one or two pages at a time; move back and forth through 
the document; zoom in and out of pages; and initiate a print job.



Print Preview toolbar

The print preview toolbar offers you the following options:
Print

Bring up the print dialog box, to start a print job.
Next Page

Preview the next printed page.
Prev Page

Preview the previous printed page.
One Page / Two Page

Preview one or two printed pages at a time.
Zoom In

Take a closer look at the printed page.
Zoom Out

Take a larger look at the printed page.
Close

Return from print preview to the editing window.



Print Setup command (File menu)

Use this command to select a printer and a printer connection.    This command presents a 
Print Setup dialog box, where you specify the printer and its connection.



Print Setup dialog box

The following options allow you to select the destination printer and its connection.
Printer

Select the printer you want to use.    Choose the Default Printer; or choose the Specific 
Printer option and select one of the current installed printers shown in the box.    You 
install printers and configure ports using the Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to 
the type of printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



Page Setup command (File menu)

<< Write application-specific help here. >>




